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 مقدمه

 

 Pdf اسناد در اينترنت است و كاربران روزانه با آن سر و كار داشته و براي تبديل فايلهاي خود از اين فرمت  ترين فرمت معروف

  Adobe Acrobat Pro ، نرم افزار خود شركت ادوبي يعني  Pdf استفاده ميكنند. قويترين و بهترين نرم افزار براي كار با 

نياز دارد در خود گنجانيده، بطوريكه هيچ محدوديتي در اين زمينه  Pdfاي  است. اين برنامه تقريبا هر آنچه را يك كاربر حرفه

 نداشته و هر كاري را كه مورد نظرتان باشد، ميتوانيد با اين برنامه انجام دهيد. برخي از مهمترين ابزارها و قابليتهاي اين برنامه را

 كنيم. بصورت عملي مرور مي
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  Pdf  ساخت
است. يك عكس، فايل متني، فايل اكسل، يك فرمت گرافيكي، فروم اينترنتي،   Pdfي كه هر كاربر نياز دارد، ساخت اولين ابزار

را بطور كامل روي ويندوز    Acrobat Pro را دارد. وقتي  Pdf ايميل و هر چيزي كه فكر كنيد، قابليت تبديل شدن به يك فايل

را فراهم  Pdfي مانند آفيس مايكروسافت ساخته ميشود كه امكان تبديل به يك فايل كنيد، يك پنل در نرم افزارهاي معروفنصب مي

 (1)تصویر ميكند . 

            

 

ساخته شود. در خود نرم  Pdfكليك كنيد و مراحل كار را ادامه دهيد تا   Create Pdfدر اين پنل كافي است روي گزينه     

تبديل   Pdfدر منوي فايل و همچنين نوار ابزار اصلي ميتوانيد هر چيزي را به  Create Pdfاز ابزار  Acrobat proافزار 

   Pdfكنيد. يك نگاه به فرمتهاي پشتيباني اين نرم افزار اين موضوع را ثابت ميكند. بسته به اينكه قصد تبديل چه چيزي را به 

         (2تصویر )داشته باشيد، ميتوانيد يكي از گزينه هاي اين بخش را انتخاب نماييد. 

 

 Pdfبخشهاي مختلف يك فايل 

در نوار بالاي صفحه، تعداد كل صفحات و شماره صفحه فعال نمايش داده ميشود. براي رفتن به صفحه بعدي و يا قبلي بايد 

 (3)تصویر نيز به اولين صفحه ميرويم            بر روي كليك كرد و با كليك          يا روي     
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با استفاده از كليدهاي مكان نماي راست و چپ نيز ميتوان صفحات را عقب و جلو كرد و در واقع كتاب را ورق زد. همچنين اگر 

بخواهيد همه كارها را با ماوس انجام دهيد، ميتوانيد با چرخاندن كليد وسط ماوس صفحات را ورق بزنيد. اما اگر بخواهيد مستقيما 

)تصویر  را همزمان فشار دهيد تا پنجره كوچكي مطابق تصوير باز شود  Shift, Ctrl,Nيد كليدهاي به يك صفحه خاص برويد، با

4) 

 

صفحه انتخابي در برابرتان قرار ميگيرد.  و يا اينكه در قسمت نشان داده شده در شكل  OKبا وارد كردن شماره صفحه و فشردن 

 ستقيما باز كنيد.كه مربوط به شماره صفحات است صفحه مورد نظر را م 3

 تنظيم نحوه نمايش صفحات 
براي اينكه بتوانيد به راحتي از متن الكترونيكي كه در آكروبات باز كرده ايد استفاده كنيد  امكانات متنوعي در اين برنامه گنجانده 

 شده است از جمله حالتهاي نمايشي مختلف براي صفحات.
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استفاده نماييد . در كادر كوچك   حه ميتوانيد از كليدهاي   براي بزرگتر يا كوچكتر ديدن صف: بزرگنمايي

كنار آن نيز درصد بزرگنمايي نشان داده شده كه با باز كردن آن ميتوانيد مقدار بزرگنمايي را انتخاب نماييد. با انتخاب ذره بين، 

توانيد با چرخاندن كليد وسط ماوس صفحه را ميتوانيد صفحات را بصورت ديناميكي تغيير اندازه دهيد. پس از انتخاب اين ابزار مي

 به اندازه دلخواه درآوريد  .

 

حالا اگر كليد چپ ماوس را پايين نگه داريد و ماوس را حركت دهيد، صفحه به راحتي در جهتي كه دستتان را حركت ميدهيد 

د صورت عمل نخواه دست به اینباید توجه داشت اگر حالت بزرگنمایی دینامیکی فعال باشد دیگر ابزار )  حركت ميكند

كه از صفحه  مانيتور بزرگتر نشده و نياز به استفاده از نوارهاي لغزنده يا ابزار  ( اگر بخواهيد صفحه در اندازه اي نمايش داده شودکرد

انتخاب نماييد. را  Fit Pageدرصد بزرگنمايي را باز كرده )با كليك روي علامت  فلش  كنار آن( و  دست نباشد، نوار نشان دهنده

 (5)تصویر 
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 انتخاب نوع صفحه بندي

 

  مختلف را ميتوان در آكروبات  تنظيم كرد: (Page Layout) چهار نوع صفحه بندي                         

براي  ميشوند.در اين حالت صفحات بصورت تكي و مجزا نمايش داده : Single Page  نمايش تك صفحه اي -1

كليك كنيد. اگر اين ابزار در نوار ابزار موجود نبود ، ميتوانيد از منوي    الت در نوار ابزار روي  انتخاب اين ح

View  استفاده كنيد: View>Page Display>… 

 در اين حالت هر چقدر هم كه اندازه صفحه را كوچك نماييد باز هم يك صفحه نمايش داده ميشود.

 

ن حالت صفحات بصورت پيوسته و پشت سرهم نشان داده ميشوند. با استفاده در اي:  (Continuous) نمايش پيوسته

صفحات قبل و بعد نيز رفت. هرچقدر درصد بزرگنمايي  از كليد وسط ماوس نيز ميتوان علاوه بر بالا و پايين رفتن در يك صفحه، به

 د.را كمتر كنيد، تعداد صفحات بيشتري را بطور همزمان روي نمايشگر خود خواهيد دي

 

با انتخاب اين گزينه صفحات همانند يك كتاب دو به دو روبروي هم نمايش داده : Two-Up نمايش دو صفحه اي -1

 (6)تصویر ميشوند. كه ميتواند به صورت معمولي و منفرد و يا پيوسته باشد. 
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را    Viewانيد منوي اگر بر اي بهتر خواندن يك صفحه نياز به چرخاندن آن داشته باشيد، ميتو :چرخاندن صفحه

 حالت چرخش را انتخاب نماييد . Rotate Viewباز كرده و از عنوان 

 گردش آسان بين صفحات 

 

 Pages استفاده از

علاوه بر امكانات اوليه مربوط به عقب و جلو رفتن در صفحات و يا رفتن به شماره صفحه اي خاص، ابزارهاي ديگري براي 

است كه ممكن است بصورت اتوماتيك پس از   Pagesيكي ازآنها پانل نمايش صفحات و يا  اين منظور در اختيار هستند.

  Navigationرفته و از عنوان    Viewباز شدن يك فايل فعال شوند. براي فعال كردن آن بصورت دستي بايد به  منوي

ا كليك روي هر صفحه مستقيما به آن را انتخاب كنيد. با فعال شدن اين پنجره در كنار متن، ميتوانيد ب  Pagesگزينه 

 صفحه وارد شويد. 

 Bookmark استفاده از
 

Bookmark  به معناي نشاني است كه در لاي كتاب ميگذارند تا بعدا راحت تر محل مورد نظر را پيدا كنند. در مطالعه

 متن و كتابهاي الكترونيكي نيز ميتوانيد از اين امكان استفاده نماييد.

هستند و معمولا فهرست محتويات فايل در قالب ليست نشانها در برابر كاربر قرار ميگيرد.   Pdfاز يك فايل نشانها جزيي 

را انتخاب نماييد تا پنجره  Bookmarkگزينه    Navigationو از قسمت   Viewبراي فعال كردن آن بايد از منوي 

 (7)تصویر  آن همانند شكل باز شود.

            

 

ينجا فصلها و يا بخشهاي يك فايل )كتاب ، مقاله، ...( بصورت فهرست نشان داده شده اند برخي قسمتها داراي بخشهاي فرعي در ا   

علامت مثبت است. براي باز كردن اين  يا زيرفهرست نيز هستند. در اين حالت مربعي در كنار آنها قرار ميگيرد كه درون آن يك
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و  تبديل ميشود –يد روي اين علامت دو بار كليك كنيد تا باز شود و پس از آن علامت + به فهرست و ديدن زير فهرستهاي آن با

اگر مجددا روي آن كليك كنيد فهرست بسته ميشود. هر كدام از عنوانها بصورت لينك هستند و وقتي ماوس روي آنها قرار ميگيرد 

ي مراجعه به يك بخش يا فصل خاص از متن حتما شماره به شكل دست نمايش داده ميشود و بدين ترتيب ديگر لازم نيست برا

صفحه آنرا بدانيد و آنرا وارد كنيد تا به آن صفحه برسيد و صرفا با يك كليك روي عنوان مورد نظر به صفحه دلخواه خواهيد رفت. 

 باشد طبعا نميتوان از چنين نيستند و اگر سازنده فايل اين بخش را در آن تعبيه نكرده bookmarkداراي  Pdf البته همه فايلهاي

 امكاناتي استفاده كرد.

 Back و  Forward  كليدهاي
 

آشنايي داريد، كليدهايي مشابه نيز در اين برنامه   My Computerيا  Internet Explorer حتما با كليدهاي عقب و جلو در 

 (8)تصویر وجود دارد كه در نوار بالا و در كنار رديف شماره صفحه قرار دارد 

 

 

به معناي نماي بعدي و نماي قبلي مي باشد كه با كليك روي آنها وضعيت  Previous View و   Next Viewنام اين كليدها 

 25بعدي يا قبلي صفحه نمايش داده ميشود كه البته بايد به تفاوت آن با كليدهاي تغيير صفحه دقت شود براي مثال اگر از صفحه 

 Previousبا كليك بر روي (   Ctrl+Shift+Nو يا   Bookmarkيا   Pagesبا استفاده از پانل رفته باشيد ) 240به صفحه 

View   خواهيد رفت  239برميگرديد در حاليكه اگر كليد برگشت به صفحه قبل را بزند به صفحه  25به صفحه.  

فحه از متن يا عكس موجود در يك صبه دلايل مختلف ممكن است نياز پيدا كنيد كه بخشي :  انتخاب و كپي بخشي از متن

منتقل نماييد. اين كار با  Wordفايل يا برنامه ديگري استفاده كنيد. براي مثال ميخواهيد بخشهايي از متن را به برنامه   دررا 

)تصویر م است.يا عكس فوري قابل انجا Snapshotيا ابزار انتخاب و همچنين  Select Toolsاستفاده از دو ابزار ساده و قوي با نام 

9) 
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كليك كنيد و نشانگر ماوس را به ابتداي    نشان داده شد    9روي ابزار انتخاب كه در تصوير  :انتخاب بخشي از متن

محل مورد نظر ببريد. كليد چپ را پايين نگه داشته و ماوس را حركت دهيد تا بخشهاي مورد نظر انتخاب شوند )رنگ آنها آبي  

را انتخاب كنيد. حالا به برنامه مقصد، مثلا   Copy to Clipboardبخش انتخابي كليك راست كرده و ميشود( سپس روي 

Word  رفته و متن را در محل مورد نظر قرار دهيد )بچسبانيد( همانطور كه ميدانيد براي اينكار بايد مكان نما را در محل مورد

 تخاب كنيد.را ان Pastدستور    Edit نظر قرار داده و از منوي 

 

 : از صفحه يعكس گرفتن از بخش

كليك كنيد و با ماوس دور قسمتي كه    نشان داده شده    9روي ابزار عكس فوري كه در تصوير 

ميخواهيد كپي كنيد كادر بكشيد. هيچ فرقي نميكند كه بخش انتخابي متن باشد و يا عكس و بعد از رها كردن كليد چپ، عكسي از 

 قرار ميگيرد .  Clipboardته شده و در حافظه موقت يا بخش مورد نظر گرف

بخش مورد نظر در برنامه  10حال به روش قبلي ميتوانيد اين عكس را در هر برنامه اي كه ميخواهيد بچسبانيد. براي مثال در تصوير 

Word  اند و نه بصورت متن و وارد شده است دقت كنيد كه در اين حالت بخشهاي متني هم بصورت عكس و گرافيك آورده شده

 (10)تصویر لذا قابل ويرايش نيستند. 
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 Pdfجستجو در يك فايل 

 

يكي از ابزارهاي بسيار مهم و كاربردي در برنامه آكروبات بخش جستجوي آن است كه با استفاده ار آن ميتوان به دنبال كلمه يا 

 Find, Search وجود دارند با نامهاي Edit ر در منويگشت. دو گزينه مشابه براي اين كا Pdfعبارتي در كل فايل 

 

 Find استفاده از دستور
(  كادر كوچكي همانند شكل در نوار بالاي صفحه  باز ميشود كه در آن F,Ctrl)يا فشردن همزمان كليدهاي Findبا انتخاب 

 (11)تصویر عبارت مورد نظر را تايپ كنيد: 

 

مي بينيد  كلمه يافت شده با رنگ مجزا  12كلمه مورد نظر جستجو شود. همچنان كه در تصوير را فشار دهيد تا   Enterو سپس 

(  محل وقوع كلمه بعدي پيدا ميشود و همين طور به جلو ميرود تا  )  Nextمشخص شده است. با كليك روي 

از يك  16براي مثال اگر در صفحه  جستجو در اين حالت از محلي كه درآن قرار داريد شروع ميشود.  دوباره به جاي اول برگردد.

رفته و  200تا  Next نيز شروع  شده و با كليك متوالي روي 16ستجو براي كلمه وارد شده از صفحه جصفحه اي باشيد  200فايل 

 همين عمل را در جهت برعكس انجام ميدهد. Previousنيز جستجو ميشود. كليد  16بعد دوباره از اول تا صفحه 
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  Search استفاده از دستور

 

يك پنجره در قسمت سمت راست صفحه اي مطابق شكل باز ميشود. با استفاده از ابزار   Editبا انتخاب اين گزينه از منوي 

 (13)تصویر موجود در اين پنجره ميتوان جستجوي وسيعتري انجام داد. 

 

 

  …In the currentبراي جستجو در فايلي كه اكنون باز است گزينه  يا عبارت مورد نظر را وارد كنيد.  رديف اول بايد كلمهدر 

كل فايل جستجو شده و  Search روي كليك با. است شده آورده تصوير روي بخشها بقيه به مربوط توضيحات. شود زده علامت

 (14)تصویر يش داده ميشود: نما 14نتايج بصورت فهرست همانند تصوير 

13 

 شروع جستجو

 جستجو در بیش از یك فایل 
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در كادر نشان داده شده، فهرست قسمتهاي يافت شده نمايش داده ميشود. براي روشن تر بودن نتيجه، بخشهايي از جمله اي كه 

 كلمه در آن قرار داشته نيز آورده شده است. اگر ماوس روي هر كدام از آنها برده شود )بدون كليك(  شماره صفحه آن ر كورد خاص

روي هر كدام از ركوردهاي يافت شده نيز كه كليك شود، آن صفحه  باز شده و در برابرتان قرار ميگيرد. براي نشان داده ميشود. 

كليك كنيد تا به عقب برگرديد. همچنين اگر از گزينه هاي پايين  New Searchجديد نيز ميتوانيد روي  انجام يك جستجوي

 یرتصو): ميگيرد قرار اختيارتان در جستجو براي بيشتري هاي گزينه كنيد كليك …Use Advanced Searchصفحه روي  

 جستجو صرفا شود انتخاب …Match Exactوار بازشو گزينه ي ن از اگر. است شكل در شده داده نشان بخش آنها مهمترين (15

 در موجود كلمات از هركدام شود تخابان … Match any اگر اما. ميشود انجام شده وارد عبارت با مشابه دقيقا عبارتي براي

 .ميشوند جستجو جداگانه هم عبارت

 

 

15 
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 جستجو در بيش از يك فايل

  
جستجو كنيد. براي اين منظور لازم نيست تك تك آنها را باز كرده و درونشان  Pdf شايد بخواهيد كلمه اي را در بيش از يك فايل 

 را …Browse for Locationرا باز كرده و از آنجا : Look inايين عبارت به جستجو بپردازيد.  كافي است منوي بازشوي پ

 شود انتخاب شده گفته گزينه بازشو منوي از سپس و بخورد علامت …All Pdf Documents . بايد ابتدا گزينهكنيد انتخاب

م است تاكيد شود كه مجموعه باز شده و آدرس پوشه محل قرارگيري فايلها را ميپرسد. لاز 16پس پنجره اي مطابق تصوير  س

 (16)تصویر قرار داشته باشند.  هپوش فايلهايي كه ميخواهيم در آنها جستجو كنيم بايد در يك

 

نتايج جستجو مجددا همانند حالت قبل بصورت فهرست وار نمايش داده ميشود با اين تفاوت كه در كنار هر عبارتي كه پيدا شده، 

 شود. يمايش داده منام فايل مربوط به آن نيز ن

 

 ابزار تكميلي 
تفاده از امكان اسظر ابزار و امكاناتي كه در اين بخش معرفي ميشوند فقط در حالتي فعال و قابل استفاده هستند كه در فايل مورد ن

 د.آنها فعال شده باشد. البته اگر از نسخه حرفه اي آكروبات استفاده شود اين ابزار در هر حالت قابل استفاده هستن
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 فسفري اژيكم

 

)هاي لايت به معني برجسته ساز( يا فسفري، در هنگام مطالعه بسيار مفيد است و ميتوان بخشها  Highlightاستفاده از ماژيكهاي 

و نكات مهم را با استفاده از اين ماژيكهاي رنگي مجزا كرد و هنگام مطالعه و مرور مجدد، خيلي سريع بخشهاي مورد نظر در برابر 

 م قرار ميگيرد. چش

قرار دارد كه در شكل نيز نشان داده شده است. اگر اين نوار را روي صفحه  Comment  &Markupاين ماژيك در جعبه ابزار 

  Comment   &Markupدر كنار  View>Toolbarsرفته  يا در نوار ابزارهاي موجود در بالاي صفحه نمي بينيد به مسير زير 

 کلیك کنید( )روی آنيك علامت بزنيد 

با كليك روي علامت ماژيك در جعبه ابزار و قرار دادن آن در محل شروع كليد چپ را پايين نگه داشته و ماوس را تا محل مورد نظر 

 حركت دهيد و رها كنيد تا يك كادر رنگي دور قسمت انتخاب شده كشيده شود. 

مربوط  ا از نوار ابزاررر متن  يا روي آن ، يا مي توانيد گزينه مطلوب براي انتخاب انواع ديگري از برجسته سازي مانند خط كشيدن  زي

ابزار مطلوب خود را از ميان طيف متنوعي از  Comment  &Markupرا باز كرده و از عنوان  Toolsانتخاب كنيد و يا منوي 

 ابزار علامت گذاري موجود انتخاب كنيد.

 

 ( Commenting) افزودن توضيحات و يادداشت
 

يتوانيد در هر كجاي صفحه توضيحات و يادداشتهاي مرتبط با آن بخش را وارد كنيد تا هر وقت خواستيد اين يادداشتها به شما م

مشخص ميشود كه   Sticky Noteبا نام   Pdfنشان داده شود. ابزار اصلي براي اضافه كردن توضيحات به بخشهايي از يك فايل 

براي مثال ميخواهيم معني برخي لغات را كه نميدانيم بصورت يادداشت در كنار متن قرار  . قرار دارد  Commentدر جعبه ابزار 
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در نوار ابزار كليك  كرده و بعد در كنار كلمه مورد نظر در صفحه كليك كرده تا پنجره اي در   دهيم. روي   

 (17)تصویر  كنار آن باز شود 

در بالاي پنجره    كرده و پس از اتمام كار روي دكمه    Copy-Pasteدر اين پنجره معني لغت را يا تايپ كرده و يا  

كليك ميكنيم تا بسته شود به اين ترتيب علامت كوچكي در محل قرار ميگيرد وقتي ماوس روي اين علامت قرار ميگيرد كادري باز 

 شده و توضيحاتي را كه در اين كادر درج نموده ايم نمايان ميشود. 

 

 تصوير مشاهده ميكنيد علامت كوچكي در محل قرار ميگيرد كه وقتي ماوس روي آن قرار ميگيرد كادري مشابه همانطور كه در

باز شده و توضيحات را نشان ميدهد. علامتي كه پس از بستن پنجره توضيحات در محل قرار ميگيرد ميتواند بنابر انتخاب  17تصوير 

را انتخاب نماييد تا صفحه اي   Propertiesراست كليك كرده سپس قسمت  كاربر تغيير كند براي اين منظور بر روي علامت

 باز شود  18تصویر همانند 

 

18 

درصد  

شفافیت 

17 

 تغییر رنگ

 تغییر شکل علامت 
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 نيز در سمت راست مشخص شده است. در اينجا فهرستي از علامتهاي مختلف نشان داده شده است. درصد شفافيت و رنگ علامت 

ايجاد كننده يادداشت ميباشد را تغيير دهيد و براي ايكنه تنظيمات  كه همان Authorنيز ميتوانيد نام  Generalگ ردر سرب

 (18تصویر  )د.نيرا علامت بز  Make Properties Defulatاعمال شده بصورت پيش فرض درنظر گرفته شود گزينه 

 مشاهده فهرست يادداشتها

 < View محل شده اند از   Highlightه براي ديدن فهرستي از كل يادداشتهايي كه اضافه كرده ايم و همچنين بخشهايي ك

Navigation Panels   بر رويComments  اين فهرست  كليك نماييد تا صفحه به دو قسمت تبديل شود و در قسمت پاييني

 (19تصویر  ) نمايش داده شود. با كليك روي هر مورد به صفحه اي كه آن يادداشت در آن قرار دارد وارد ميشويد.

 

 

 Pdfبه    Word تبدیل فایل  -Pdf  :1 لهايساختن فاي

 

را مشاهده مي   Pdfبه   Wordنحوه تبديل يك فايل  20تصوير تبديل كرد. در   Pdfانواع مختلفي از فايلها را ميتوان به 

 نماييد  كه براي تبديل آن راههاي مختلفي وجود دارد .

را   Create Pdf -3منوي فايل را باز مي كنيم  -2مي شويم   Acrobat Professionalوارد برنامه  -1: اول وشر

و نوع  فايل مورد نظرمان را پيدا كرده و انتخاب مي كنيم -5را انتخاب مي كنيم   From fileگزينه  -4انتخاب ميكنيم 

ساخته  و در انتها فايل آغاز ميشودPdf بر روي نام فايل دو بار كليلك مي كنيم. مراحل ساخت  -6فايل را مشخص ميكنيم 

 (20تصویر  ) شده در محيط آكروبات نمايش داده ميشود.
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و  Save as و يا  Save سپس فايل ساخته شده ذخيره نماييد. براي اينكار منوي فايل را باز كرده و با استفاده از دستور 

 .با مشخص كردن نام فايل و محل ، فايل را ذخيره نماييد 

 

به فهرست چاپگرها اضافه  Adobe Pdf يك چاپگر با نام   Acrobat Professionalد از نصب برنامه بع: روش دوم

ده از دستور چاپ و انتخاب اين پرينتر ميتوانيد فايلهاي خود را به اميشود به اين ترتيب در هر برنامه اي كه باشيد با استف

Pdf  .(21 تصویر) تبديل كنيد 

. از منوي فايل گزينه پرينت را انتخاب نماييد سپس از نشان داده ميشود Wordنامه پنجره چاپ در بر 21در شكل 

كنيد مشاهده ميكنيد كه بجاي چاپ روي كاغذ در يك فايل   OKرا انتخاب نماييد و   Adobe Pdfقسمت پرينتر نام 

Pdf  چاپ ميشود و در واقع به يك فايلPdf  .تبديل ميشود 

 
 

 
 

 

21 

21 
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و يا   Bookmarksبا استفاده از روش شرح داده شده )دستور پرينت( هيچكدام از  Pdfفايلها به با تبديل   :توجه

Links    براي حل  يكسان برخورد ميشود.بصورت معمولي و موجود در فايل تبديل نمي شوند  و با همه بخشهاي متن

و يا منوي ويژه  استفاده كرد(Adobe Pro) در برنامه آكروبات حرفه اي   Create Pdf اين مشكل بايستي از دستور 

  و يا برنامه هاي مبدا وجود دارد استفاده كرد. Word برنامه اي كه در خود 

 

  Bookmarks نحوه ساختن

 Add ابتدا عنواني را كه ميخواهيم براي آن نشان گذاري شود را انتخاب كرده و روي آن راست كليك كرده و  

bookmark   (22 تصویر) را انتخاب ميكنيم 

 

 
 

شده و آماده  Bookmarkدر اين مرحله پنجره نشانه ها در سمت چپ پنجره باز شده و عنوان انتخابي در فهرست 

كليد اينتر را فشار دهيد تا نشانه ثبت گردد. اين كار را براي  سويرايش مي باشد تا در صورت لزوم نام آنرا تغيير دهيد سپ

 (23 تصویر)تا فهرستي مثل شكل زير درست شود. ظر نيز انجام دهيد. ديگر عنوانها و بخشهاي مورد ن
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 .حال با كليك بر روي هر كدام از عنوانها مستقيما به صفحه اي كه آن نشان براي آن تنظيم شده است ميرويم

 

 به يك صفحه (Link) پيوند
براي  آن فهرست عنوانها نشان داده شده استنشان دهنده صفحه اول فايلي است كه آنرا تبديل كرده ايم و در  24تصوير 

اينكه استفاده از اين فهرست راحت تر شود ميتوان كليه عنوانها را به پيوند تبديل كرد. بدين منظور ابتدا بايستي كلمه يا 

تا صفحه زير باز  كردرا انتخاب  Create Link  كلمات مورد نظر انتخاب شوند سپس بر روي آن راست كليك كرده و 

  .شود

 

 
 

24 
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 تصویر). را كليك كنيد  Nextنوع پيوند مشخص ميشود گزينه اول را انتخاب نماييد و   Link Actionدر قسمت 

25) 

 
 

 كردن نوع پيوندمشخص 

 

 
 

 
 

كليك   Set Linkپس از آن بصورت اتوماتيك به متن برميگرديم اكنون بايستي به مقصد مورد نظر رفته و سپس روي 

 (26 تصویر) نماييد.

25 

25 



21 
 

 

 

 فايلها به يك فايل پيوسته تبديل

 

مختلف داشته باشيم و بخواهيم آنها را بهم متصل كرده بصورت يك فايل واحد درآوريم گزينه  Pdfاگر چند فايل  

Create  و سپس  كليكرا Combines file into a single pdf  27 تصویركرده تا صفحه اي مطابق را انتخاب 

 . باز شود

 
 

27 

26 
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ميتوانيد فايلهاي مورد نظر در قسمتهاي مختلف كامپيوتر خود را پيدا كرده و آنها را   Add Filesبا كليك بر روي 

 (28 تصویر). انتخاب نماييد 

 

 
 

براي مشخص نمودن ترتيب قرار گيري آنها در فايل نهايي بايستي آنها را در ليست بالا و پايين كرد بدين منظور بايستي بر 

آنها را بالا يا پايين برد و   Move up, Move Downو سپس با استفاده از كليدهاي  هكردروي فايل مورد نظر كليك 

 (29 تصویر)را كليك نمود.   Combine Fileدر انتها كليد 

 

82  

29 
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 چاپ بخشي از يك صفحه 
 

نتخاب است. پس از ا  Snapshotاگر بخش خاصي از يك صفحه را ميخواهيد چاپ كنيد، بهترين راه استفاده از ابزار 

 Selected Graphicدر اين حالت گزينه اي با نام   (File>Print)صفحه مربوط به چاپ را باز كنيد بخش مورد نظر 

 (30)شکل  .ميشود  آغاز قسمت انتخاب شده چاپ  OKرا انتخاب نماييد و با كليك بر روي 
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وان نينكه سازنده فايل مجوز دسترسي را داده باشد. بعانجام داد منوط به ا  Pdfكارهاي مختلفي ميتوان بر روي فايل 

مثال ممكن است شما نتوانيد از فايلتان نسخه چاپي تهيه كنيد. براي اينكه بدانيم چه كارهايي را ميتوانيم در يك فايل 

Pdf  انجام دهيم بايد از منويFile    گزينهProperties  گ ررا انتخاب كنيم و سپس سربSecurity  خاب را انت

 (31 تصویر)كنيم . 

 

 
 

 
 

31 
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 ه معني مجاز مي باشد.بنوشته شده  Allowedعبارت    Printingبعنوان مثال در روبروي 

 تنظيمات امنيتي
البته مشروط بر داشتن مجوز اعمال از سوي ميتوان انجام داد  Pdfكارهاي مختلفي را بر روي يك فايل                    

مثال اگر سازنده مجوز چاپ را براي كاربر مجاز نساخته باشد نميتوان از صفحه مورد نظر نسخه چاپي سازنده فايل. بعنوان 

 .تهيه كرد

 Doucumentگزينه   Fileهستيم بايد از منوي  pdfبراي اينكه بدانيم مجاز به انجام چه كارهايي در يك فايل 

Properties   را اتنخاب كنيم و سپس سربرگSecurity  (  32 تصویر) نماييم .را فعال 
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 به معناي مجاز  Allowنوشته شده   Changing the Documentبراي مثال در روبروي 
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 را انتخاب نماييد تا صفحه زير باز شود  Password Securityمنوي نشان داده شده در عكس را باز كنيد و از آنجا 

 
 … Require a passwordكردن يك رمز قادر به باز كردن و خواندن فايل باشند  اگر مي خواهيد كاربران صرفا با وارد

 را علامت دار كنيد. )قسمت الف(

را علامت دار كنيد )قسمت ب( و در كادر پايين  … Restrictاگر مي خواهيد امكان چاپ را محدود يا مسدود نماييد 

 ز را بدانند ميتوانند فايل را چاپ نمايند.رمز را وارد نماييد و در اين حالت تنها كاربراني كه رم

 را انتخاب نماييد  Printing Allowedد روبروي اري تعيين مجوز چاپ بايد يكي از موبرا

- None  بصورت كلي دسترسي به چاپ را مي بندد 

- Low Resolution  امكان چاپ با كيفيت پايين 

- High Resolution   امكان چاپ با كيفيت بالا 

علامت دار شود كاربر ميتواند با استفاده از ابزار انتخاب و عكس فوري   … Enable Copyingار اگر مربع كن

 كنيد و خارج شويد.  OKبخشهاي دلخواه را كپي نمايد. گزينه آخر را نيز بدون تغيير بگذاريد 
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